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Welcome to the latest edition of my monthly Final Cut Studio newsletter. This is the February/March 2007 
edition. (Sigh, I wanted it to be just the February issue, but, somehow, the month just got away from me.)

The goal of this newsletter is to provide information helpful to the professional user of Final 
Cut Pro. This newsletter publishes each month. Past issues are not archived. However, key 
articles are posted on my website for your reference. All software references are to Final Cut 
Studio unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. We now have over 140 
tutorials to help you get the most out of Final Cut Studio!
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Welcome!

Sorry for being gone so long. I discovered that my three-week seminar tour of England and Ireland made it 
impossible to write this newsletter. (And Edit Well deadlines always take precedence, as well.) 

The tour went really, really well. It was fun to present to Final Cut User Groups in Birmingham, Bristol, and 
Dublin. And, meeting Final Cut editors from all over the UK (even from as far afield as Rome) was, for me, 
the highlight of the seminars.

I also brought my audio gear along and interviewed a host of folks -- including the heads of the Briston and 
Dublin user groups. The interviews start this month in Edit Well, and will continue for the next couple of 
months.

We are already working on our next seminar tour for the second half of this year. I'll be able to tell you more 
about it in June.

Still, I missed writing this newsletter and am looking forward to getting caught up with all your questions 
and comments. Also, please remember to check back a week or two after this newsletter is published to 
review the updates based on reader feedback. There are always updates. 

[ Go to Top. ] 

TWO New Versions of Final Cut Pro

Recently, Apple released two new versions of Final Cut Pro -- 5.1.3 and 5.1.4.

Version 5.1.3, released in mid-February, has a significant bug which disables many 3rd-party plug-ins, such 
as Automatic Duck, Conduit, and many others. Apple says the bug was fixed in the 5.1.4 version, released 
at the end of February.

While it is a bit too early to know how stable the 5.1.4 release is, though I have not read anything negative, 
I am completely impressed with the 5.1.2 release of Final Cut. This version is outstanding -- and I 
encourage anyone that hasn't yet upgraded to it to consider doing so, if your system will support it.

Here's where you can go to check the system requirements of Final Cut Pro.

http://www.apple.com/finalcutstudio/specs.html?finalcutpro


The new version is available for download from Apple’s Web site.
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New Version of DVD Studio Pro

Also, on March 2, Apple released a new version of DVD Studio Pro - version 4.1.2.

This new update addresses a compatibility issue with HD DVD projects and Toshiba HD DVD players. It 
also fixes problems related to HD DVD replication. In addition, Apple also notes it contains “important bug 
fixes.”

The new version is available for download from Apple’s Web site.

[ Go to Top. ] 

New Product Listing Service on our Website

We are adding a new feature to our website (www.larryjordan.biz) to present new product announcements 
related to Final Cut Studio. As well, you'll be seeing more new product announcements in this newsletter. 

Rolling out later in March, this section will make it easy to learn what's new for the Final Cut community.

If you have a product you'd like us to mention, please send us your information, suitable for posting, and 
we'll make sure to list it.

There's no charge for this service. We'll announce it on our home page when it's ready.

[ Go to Top. ] 

Apple Announces an NAB Event

Apple has announced a special event on Sunday, April 15, to be held at NAB.

Apple has traditionally used these events to announce new versions of Final Cut Studio -- so speculation is 
running rampant on what Apple will be announcing this year.

I've already got my invitation safely tucked in my pocket and am looking forward to attending. As soon as 
the announcement is made, we'll be covering it here and, in depth, in Edit Well.

[ Go to Top. ] 
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New! Daily Tips on Final Cut Pro

In association with Peachpit Press, I'm delighted to announce a new series of daily Final Cut Studio tips -- 
emailed directly to you. 

Each of these short daily suggestions is designed to help you get more out of Final Cut Studio. While we 
will cover all the applications in Final Cut Studio, our main focus is Final Cut Pro.

The Daily Tips are free -- to sign up, click here.

If you have a tip you'd like me to share, email me so I can share it with the world. 

[ Go to Top. ] 

2007 Business Survey

In my last issue, I invited you to participate in a survey concerning your business outlook for 2007.

Hundreds of you provided your opinions and I was blown away by the results. So much so, in fact, that we 
shared the results of this survey with the world-wide press.

Here's the press release we issued, covering the results of the survey:

http://larryjordan.biz/about/press/2007_2.html

Because you participated in the survey, I want to share a bit more of the results with you than we put in the 
press release. First, I was struck by how many editors are working in very small shops -- 94% of everyone 
answering the survey works either alone, or with only a few other editors. This means that most of you are 
pretty much on your own for training, support, and developing your business.

http://www.peachpit.com/newsletters/index.asp?rl=1
mailto:larry@larryjordan.biz?subject=Final Cut Tip
http://larryjordan.biz/about/press/2007_2.html


Second, while the majority of you are editing as a full-time job, the number of editors who are only part-time 
is almost a third of the total This suggests that keeping editing skills current for this group might be difficult 
because there are many other demands on your time. 

Third, I was struck by the answers to a question we purposefully did not include in the press release - your 
thoughts on how soon HD is likely to take off. Like the rest of the industry, there is a lot of "wait and see" 
going on.

Finally, we asked for your comments on what you saw as your biggest business challenges for 2007. This 
was the most eye-opening part of the survey for me -- because your concerns fell into three broad 
categories, none of which included improving your editing skills:

●     Managing money
●     Managing clients



●     Managing time

We are at work incorporating your ideas in new training that we tested during our recent UK seminars. 
Based on feedback from those seminars, we hope to provide more training in this area later this year.

Thanks for taking the time to complete the survey. We'll be doing this annually from now on so we can see 
how well our projections match reality.

[ Go to Top. ] 

Equipping Your Final Cut System

Brendan McCullough, of Cincinnati, Ohio, sent me an email which was the trigger for this article.

I graduated college two and a half years ago and have been doing freelance video editing 
and production for three and a half years. 2007 is my year to take the plunge and get some 
gear. My plan is to get a Mac Pro and Final Cut Studio, but the cost of entry is steep, 
especially living on the salary of a budding freelancer (i.e., limited, sporadic income). 

I've built more than my share of PCs and am quite comfortable getting into the guts of the 
computer, so I ask you: does it make sense to buy a Mac Pro with the baseline hard drive 
and memory options and upgrade myself (paying careful attention to the Apple compatible 
hardware guidelines) in order to save money, or am I missing something coming from a DIY 
PC mindset?

What else would you suggest to someone putting together their first editing rig? I know I 
shouldn't think too large to start, as I'll be stuck in corporate video land and shouldn't need 
too many bells and whistles.

Larry replies:

While entire catalogs are devoted to this subject, here are some general guidelines you can use. (To other 
readers, feel free to suggest products you like as well and I'll add them to the next issue.)

The first big issue you need to address is what video format you intend to edit. DV and HDV have relatively 
few equipment requirements. Beta SP, DigiBeta and most flavors of HD are much more equipment 
intensive.

Computer

First, you need a Macintosh. Any Mac, except a Mac Mini, will handle DV. If you are working with HDV, an 
Intel-Mac will be better. If you are working with formats other than DV/HDV, a G-5 or Mac Pro that allows 
you to add PCI cards will be very useful.

Lots of people are very successfully editing DV and HDV on iMacs and MacBook laptops.

RAM



Final Cut is disk-based, more than RAM-based. Motion, on the other hand, is RAM-based. I've found that 
between 1.5 and 2.5 GB of RAM is fine for Final Cut. Don't add more than 4 GB of RAM -- Final Cut is not 
able to use it. Make sure you have at least 1 GB of RAM.

You can buy RAM on the open market and upgrade your system. However, and this is important, 
Macintosh systems are MUCH more finicky about RAM than PCs. For this reason, don't buy on price, buy 
from a vendor that actually understands Mac RAM. Also, you need to specify the EXACT Macintosh system 
you have, as RAM specs vary by system.

A vendor I like, though certainly not the only one, is Crucial Technology.

Hard Disks

Final Cut requires at least two hard disks. While you can, in an emergency, edit to the internal drive of your 
laptop, this is neither recommended nor wise. Get two drives.

If you computer supports it, internal drives will be cheaper than external drives. An internal drive on a G-5 
or Mac Pro will be faster than an external FireWire drive.

Adding an second internal drive is easy. Again, like RAM, make sure you are buying a hard drive 
specifically designed for the Mac it is going in. G-5 and MacPro systems require all internal drives to use 
SATA.

If you have a G-4, iMac, or MacBook, an external FireWire drive will be fine; iMacs and MacBooks don't 
have room for a second internal drive. 

If you have a G-5, MacBook Pro, or Mac Pro, you may be better off with a SATA external drive. SATA, 
however, requires a PCI card to attached the drive to your computer. (See my review below on the LaCie 
d2 Quadra drive. Or this article from last month's newsletter on choosing between a FireWire or SATA hard 
drive.) 

The benefit FireWire provides is portability -- you can connect it to any Mac. The benefit SATA provides is 
much greater speed for about the same price -- anywhere from 2 - 5 times faster than FireWire 400.

If you plan to work with HD, not HDV, you will probably be better off with a RAID, which provides greater 
storage and speed than a single hard drive. There are six kinds of RAIDS:

●     RAID O - inexpensive, very fast, no data redundancy
●     RAID 1 - for servers only, not for video editing
●     RAID 3 - more expensive, fast, provides data redundancy 
●     RAID 5 - more expensive, fast, provides data redundancy
●     RAID 50 - very expensive, very fast, provides data redundancy
●     RAID 60 - very expensive, very fast, provides extra data redundancy

SATA speeds currently are about 30% slower on laptops than on towers due to how the SATA card 
communicates with the data bus on a laptop. 

Computer Monitor

The most important thing to keep in mind about your computer monitor is that you can NOT make final 

http://www.crucial.com/
http://www.larryjordan.biz/articles/lj_firewire_sata.html
http://www.larryjordan.biz/articles/lj_firewire_sata.html


decisions on color or interlacing by looking at it. The computer does not display video colors or interlacing 
accurately. 

If you are working with NTSC or PAL, any size monitor will be fine. If you are working with 720p HD, a 20-
inch monitor is recommended. If you are working with 1080i HD, a 23-inch monitor is recommended. By 
using View > Video Playback > Digital Cinema Desktop Preview, you'll be able to see your HD image at 
full-resolution on your computer monitor.

Whether you buy one or two computer monitors is up to your budget and style of working. Final Cut 
supports both.

Video Capture Card

If you are working with DV, or FireWire-based video, you probably don't need a capture card.

However, if you are working with any analog format, such as Beta SP or VHS, digital formats, such as 
DigiBeta, or any HD format, especially including HDV, a capture card is probably in your future.

A capture card has three main functions:

●     To capture video from a source and convert it into a form Final Cut can edit
●     To monitor your video while you are editing
●     To output your video to tape

If you are using HDV, something you might consider is converting it from HDV into DVCPROHD for editing. 
This can provide both an improvement in image quality as well as much faster editing and outputting. A 
capture card can handle this conversion during capture in real-time.

There are two leading brands of capture cards:

●     AJA
●     Blackmagic Design

Each has a variety of products to work with the wide variety of video formats and connectors currently in 
industry use. 

I'm also reading good things about Aurora Video Systems, which provides converter boxes that take VHS 
tape output and convert it to FireWire.

Video Monitor

In spite of all the industry hype about LCD and Plasma monitors, the problem is that they don't display 
video color or interlacing correctly. Which means you can't trust them to do what you most need a monitor 
for -- to display your video images accurately so you can see what's actually there.

In the past, I recommended the Sony PVM-14L2 monitor as an industry standard. However, Sony stopped 
making them a year or so ago. If you can buy a used one on E-bay, great.

If not, JVC makes a very nice video monitor - the TM-H150CGU. 15-inch, NTSC and PAL, 4:3 and 16:9. 

http://www.aja.com/
http://www.blackmagic-design.com/
http://www.auroravideosys.com/products/
http://pro.jvc.com/prof/attributes/features.jsp?feature_id=01&tree=&itempath=null&model_id=MDL101461


This is a great choice for anyone doing SD work. Howeer, it is not the right choice for HD. 

The problem with HD monitors is that they are desperately expensive. At this moment, for people that don't 
have a champaign budget for monitoring HD, your computer monitor is your best choice. Just keep in mind 
that it will not properly display interlacing or color.

Audio monitor

First, don't mix on headsets. They are too good, with too much separation between the channels. You need 
to use speakers.

Second, cheap multimedia speakers don't let you hear the sound that is there.

You need to buy some decent audio monitors. However, this does not mean that you need to rob a bank to 
pay for them. Good monitor speakers will run around $400 - 500 a pair. Here are some brands to consider:

●     mAudio Studiophile BX-8 or DX-5
●     Event
●     Tannoy
●     JBL
●     Roland MA-25 (especially good where physical abuse is likely - however, this speaker is no longer 

listed on the Roland web site). 

Audio Mixer

You have two options for audio mixers:

●     A device that simply controls what audio source is being fed to your speakers
●     A device that controls the audio sliders inside Final Cut and/or Soundtrack Pro.

For the first option, I am a huge fan of Mackie mixers. The 1402-VLZ is perfect for DV and the 1604-VLZ is 
great for four-channel audio like DigiBeta or DVCPROHD. Virtually indestructible, pervasive, and easy-to-
run.

These mixers allow you to easily monitor all the different audio sources in your edit bay -- such as the 
computer, tape deck, DVD player and so on.

However, these mixers don't allow you to control Final Cut or Soundtrack Pro. To do that, you need an 
"external control surface" that supports the Mackie Control Protocol.

These devices are much more expensive than a straight-forward mixer. Companies that make them include:

●     Mackie
●     Yamaha
●     Tascam

(As a note, I have had problems in the past connecting a Tascam FW-1082 mixer to work reliably with 
Soundtrack. Make sure you test any system for reliability before committing yourself to a deadline.)

http://www.m-audio.com/
http://www.event1.com/
http://www.tannoy.com/
http://www.jblpro.com/
http://www.mackie.com/products/mixers/index.html
http://www.mackie.com/products/mixers/index.html
http://www.yamaha.com/yamahavgn/CDA/ContentDetail/ModelSeriesDetail/0,,CNTID%253D30407%2526CNTYP%253DPRODUCT,00.html
http://www.yamaha.com/yamahavgn/CDA/ContentDetail/ModelSeriesDetail/0,,CNTID%253D30407%2526CNTYP%253DPRODUCT,00.html


Uninterruptible Power Supply

A UPS is, essentially, a large battery that will power your gear in the event of a power failure. I recommend 
them highly. Two good companies are:

●     APC
●     Tripplite

Make sure you get a UPS that is designed for your gear. The ones often sold in stores are not sufficiently 
powerful to run a MacPro or G-5. And an underpowered UPS is worse than no UPS at all. Visit the 
manufacturer's website and run their on-line sizing system. It will tell you what size UPS to buy.

Also, DON'T plug your AV gear into the UPS. You should connect your computer, computer monitor, hard 
disks and all network gear. These are what you want to stay on when the power goes off. 

If the power fails, you may lose a capture, or an output. But what you want to be sure of is that your 
computer will be up and running so you can save all your work and, if necessary, still access the internet.

Conclusion

Noticeably missing from this list is all the software you can buy. That is a much bigger list - and, really, 
varies depending upon the kind of editing you are doing. I'll save that for another time.
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Deciding What to Buy

Edward Julbe, from the Miami-Dade Fire Rescue Media & PR Bureau:

In the very near future, we will be receiving some funds from a grant to complete an 
educational video. I will have access to these funds to purchase video production equipment. 
Currently I work in the DV (DVCAM and Mini DV) format. I'm thinking of moving up to HDV, 
but I'm a bit hesitant. I've read about the format's quirks in your FCP HOT book, as well what 
you talked about in your seminar that I attended. Currently, I have a Dual 2 Ghz G5 with 2GB 
of RAM. Is this enough CPU power to edit
HDV natively without converting it to the intermediate codec? If I have to convert, and suffer 
a quality loss as a result, is it really worth it?

Also, can I mix HDV and DV footage on the same timeline. Since all of my library is DV or 
DVCAM, this is obviously very important. Lastly, is it true that if I go with the new JVC 200 
HDV cam I have to
use a JVC HDV deck? A deck from a different manufacturer will not work??

Larry replies: Edward, these are all very good questions. My personal feeling, which is not universally 
shared, is that HDV is a good format for hobbyists, but not a good format for professional work. 

Consequently, if you are moving to HD, I'd suggest the Panasonic AG-HVX200 shooting DVCPROHD, 
rather than an HDV camera, even though we have not yet solved the question of how to archive media 

http://www.apc.com/index.cfm?isoCountryCode=us
http://www.tripplite.com/
http://catalog2.panasonic.com/webapp/wcs/stores/servlet/ModelDetail?displayTab=O&storeId=11201&catalogId=13051&itemId=93120&catGroupId=14571&modelNo=AG-HVX200&surfModel=AG-HVX200


from a P2 camera.

Also, you are correct. As of today, HDV is a very splintered format. Images shot on one camera are not 
necessarily compatible with another camera or deck. Consequently, you will need to buy your deck from 
the same company that bought your camera.

[ Go to Top. ] 

This Month in Edit Well

I am delighted to be the editor of Edit Well, the rich-media newsletter for Final Cut Studio, published by 
Peachpit Press. The February issue is our largest ever -- 54 pages! Here's what you'll find in the current 
issue:

●     Audio interview with Pete Lawrence, who is leading the BBC's conversion to Final Cut Studio
●     Using Replicator - the Ginsu Knife of Motion
●     Ingesting P2 and HVD Media
●     Ingesting and Editing XDCAM media
●     Creating Special Effects in Final Cut Pro with Conduit
●     Keyframing in LiveType and Motion
●     Video tutorial on ingesting P2 media
●     Audio interview with Brad Bretz, who's using Final Cut Studio to support the worship services of a 

4,000 member church.

Edit Well contains Final Cut Studio video tutorials, audio interviews, techniques, keyboard shortcuts and 
tips that you just can't find anywhere else. In Edit Well, you don't just read about it.. you also watch and 
listen to it. And, at only $59 per year, this is a GREAT deal!

Click here to view the Table of Contents. Click here subscribe: www.peachpit.com/editwell.

If making the most of Final Cut Studio is important to you, take a few minutes and subscribe to Edit Well. If 
you have any problems subscribing, send me an email.
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Product Review - LaCie d2 Quadra hard disk

Shortly after I reviewed the CalDigit S2VR Duo RAID in last month's newsletter, I got an email from LaCie 
asking if I would be interested in looking at one of their drives -- the d2 Quadra.

Well, anytime someone wants to send me a free drive to look at, I'm happy to help, so I said yes. The drive 
arrived the day before I left for my UK seminar tour. 

I had three deadlines to meet during my UK tour - teaching the seminars, editing the February issue of Edit 
Well, and editing a corporate video that I shot just before leaving on the trip. I captured all the video -- 

http://www.larryjordan.biz/assets/nxltr33/ew09_toc.pdf
http://www.peachpit.com/editwell
mailto:larry@larryjordan.biz?subject=Edit Well Problems
http://www.lacie.com/products/product.htm?pid=10869


about 55 GB worth -- to the LaCie, loaded all my seminar demo files, wrapped the drive in plastic, tossed it 
in my computer case and off we went.

My goal was to use the drive as my second drive in all my seminars, plus edit the corporate video in the 
evenings.

The nice thing about the drive is that it has four interfaces on the back:

●     eSATA
●     FireWire 800
●     FireWire 400
●     USB 2

First, never use USB2 for video on the Macintosh. The drivers are not fast enough and it will not work.

Second, the speed of the drive is directly dependent upon which port you are using. As the following 
screens make clear, when looking at average data speed, the specs published by the manufacturer do not 
match real-world speeds. For instance, on the d2: 

●     FireWire 400 runs about 36 MB/second
●     FireWire 800 runs between 55-62 MB/second, depending upon whether you are reading or writing 
●     SATA (to a MacBook Pro laptop) runs between 69 - 72 MB/second, again, depending upon whether 

it is a read or a write. 

On the side of the box, the drive specs show the maximum speed for the bus, not the actual speed of the 
drive. Drive speed is ALWAYS significantly less than bus speed. Also, drive speed is faster when it is 
reading or writing larger blocks of data. 

Here are the results of my speed test: 



FireWire 400 results: 35 - 39 MB/sec when using larger block sizes. 

FireWire 800 results: 55 - 62 MB/sec when using larger block sizes. Note that this is significantly below the 
maximum speed of the FireWire 800 bus, because a single drive is not fast enough to fill it.

 
FireWire eSATA results: 70 - 73 MB/sec when using larger block sizes. SATA does not suffer from the 
speed slow-downs of FireWire, as it does not require a bridge chip for data translation. 

The LaCie has a three-position rocker switch in the back which allows you to turn the drive on, set it to 
automatic on/off, or turn the drive off. However, the switch doesn't work when connecting the drive using 



SATA.

The drive is in a rugged metal case, performs well and seems reliable. However, I stopped using it after my 
first seminar. The reason? It kept spinning down. That meant that whenever I wanted to demo something, I 
needed to wait for the drive to spin up. This spin-down occurred even when I set System Preferences > 
Energy Saver to never have the hard disk spin down. 

Most of the time, in editing, I'm using the hard drive constantly, so it never spins down. But, when it does, it 
always takes 10 - 15 seconds to get back up to speed. This just plain drove me nuts.

For the last year, I've been using a G-Tech drive that never spins down. Amazing quet and extremely 
rugged, it was always available -- which really smoothes out my editing process.

The LaCie drive is perfectly OK. It's speeds are fine, though not great. But I'm happy to send it back -- the 
spin down alone makes me want to look for a better drive.
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Larry's Store Special - Motion & LiveType Training DVDs

http://www.g-technology.com/


  
  
  
  
  
  
  
  
  
  

For the month of March, we are running a special promotion in our store -- buy both our Motion and 
LiveType training DVDs for one low price: $134.00. Save 10% !

Here's the Table of Contents of the Motion DVD.

Here's the Table of Contents of the LiveType DVD.

All DVDs include hours of narrated QuickTime movies and all exercise files. If you want to improve your 
skills with effects, these two titles can help.

Click here to order - remember, this special ends March 31, 2007.
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Setting LiveType for 16:9 Projects

Tony Liuzzi, and many editors in the UK, were asking how to configure LiveType to work with 16:9 
material.

The answer took me a while to figure out -- mainly because you need to configure LiveType manually for 
16:9 sequences. What I did intially was to change the width setting in LiveType, then the aspect ratio in 
Final Cut.

UPDATE: Then, when I had it all figured out, Tom Wolsky wrote in with:

This is quite wrong. This is not the way to do this. You're massacring the pixels.

DV 16:9 is always anamorphic. It's always squeezed in NTSC or PAL. SD 16:9 is also 
anamorphic. The way to handle this material is not to change the width of the image but to 
change the pixel aspect ratio. LiveType supports pixel aspect control.

For DV NTSC the pixel aspect ratio is 1.25. I'm sorry I don't know off the top of my head the 
pixel aspect ratio for the other formats, but you absolutely should not treat them as square 
pixel projects. The correct frame format should be used for all projects only the pixel aspect 
should be changed. Once the pixel aspect ratio has been changed to the correct value in 
LiveType nothing needs to be done to the project in FCP, other than fixing the alpha 

http://www.larryjordan.biz/goodies/Motion_TOC.pdf
http://www.larryjordan.biz/goodies/LiveType_TOC.pdf
http://www.larryjordan.biz/cgi-bin/ecommerce/ac/agora.cgi?p_id=00053


interpretation.

Larry humbly apologizes to all the massacred pixels and herewith removes his egregious attempt at pixel 
manipulation in favor of Tom's much more better way. 

If anyone knows the correct pixel aspect ratio to use in LiveType, let me know and I'll add it here. 

UPDATE 2 : Matt Davis writes in to say:

The pixel aspect ratio to use in LiveType for PAL projects is 1.42

UPDATE 3: To which Chris Roberts adds:

However, on importing the LiveType project into FCP you still need to manually check it as 
anamorphic. 

Larry replies: Thanks to both Tom and Matt for these much better methods of doing this. 
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Changing Imported Graphics Durations

George Mauro sent me the following tip:

If you import a graphic into Final Cut, it's default length is two minutes, with a 10 second 
duration. However, I've been doing a lot of work with animators who send me Targa image 
sequences and background plates.

To import a Targa image sequence, I go to Final Cut Pro > User Preferences > Editing tab 
and change the Still/Freeze duration to one frame, them import the images. Poof! Instant 
animation.

But, what if the background plates have to run longer, say three minutes or ten?

Did you know that if you go back to User Prefs and change the duration to 60 minutes, you 
can import a background plate and have a very, VERY long clip?



Magic.

Larry replies: Thanks, George. Great tip.
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New Final Cut Plug-ins Announced

John Wainwright, of Lyric Media, writes:

Hi Larry. This is just a short note to let you know about a new set of video effects filters for 
Final Cut from Lyric Media. The kit comprises about 50 video filters, including a range of 
photographic and stylistic special effects and 15 new matte filters. They were initially inspired 
by my experiences with Photoshop and the techniques you use in it with digital photography, 
particularly effect masking and image self-compositing. I think some of them come nicely 
across to video.

You can get more details and view a gallery of the effects available on the kit's web page 
here: http://www.lyric.com/fcp-plugins/lyric-effects/index.html

Hope you get a chance to check them out. 

Larry replies: John, these look really cool. Thanks for letting me know. And, if anyone else has a new 
product announcement, please let me know and I'll share them in future newsletters.

[ Go to Top. ] 

Saving Filter Settings

Joe Hackett, a former student, writes:

Your class was AWESOME! I took an FCP Advanced class with you at Video Symphony last 
year. Thanks!

I discovered a work-around that I thought you might enjoy.

In FCP if you throw out the preferences, you also lose all your Favorite Effects. This means 
any special filter settings are gone.

However, if you drag the patch of the filter settings (a color correction favorite, for example) 
from the Viewer...

http://www.lyric.com/
http://www.lyric.com/fcp-plugins/lyric-effects/index.html


to the Project in the Browser (not the effects tab, but the project tab area, it will REMAIN 
even after you throw out all of the preferences!

Thanks Larry!

Larry replies: Thanks, Joe. You can drag either the hand icon, as you illustrate, or the name of the filter 
from the Filters tab of the Viewer.

[ Go to Top. ] 

A Faster Way to Rename a Clip

John Gallagher writes:

I've just discovered it, a keyboard shortcut for FCP5 to rename a clip, bin or sequence! 

I've wanted to do this for a bit, as it's a bit fiddly to click twice with the mouse (call me lazy 
but I prefer to do stuff like this with keys if I can). I've tried a few times to rename using the 
same principle as in the Finder, by pressing Enter on the clip, but this just opens the clip 
sequence or bin. 

The secret is to press Enter on the Numeric Keypad, which seems to do the trick. Hurrah! 

Larry replies: Cool, thanks!

[ Go to Top. ] 

Technique: Converting Markers to Subclips



John Gallagher writes:

I use markers and subclips a lot. Is there any way, after creating several markers within 
several pieces of footage, I can convert all markers in all the bits of footage to subclips in 
one fell swoop? I've tried "Find All" with searching for Marker in the type field.

There's probably no way to do this, I just wondered.

Larry replies: Yes and No.

There's no way to create subclips from markers in multiple clips all at once. But there is a VERY cool way 
to instantly turn all the markers in a single clip into subclips. 

Here's how to do it.

1.  Load a clip from the Browser into the Viewer.
2.  Put your playhead where you want a subclip to start and place a marker by typing "M". You can put 

as many markers in a clip as you want.
3.  Notice that the clip in the Browser now has a triangle next to the name. Twirl down the triangle to 

see a list of all your markers. 
4.  Rename the markers as you wish.
5.  Create a new Bin in the Browser (press Command+B).
6.  Here's the magic part... select and drag all the markers from the clip in the Browser into the bin you 

just created. As soon as the markers are dropped into the Bin they are instantly converted to 
subclips.

This is a very, VERY fast technique!

[ Go to Top. ] 

Two Better Ways to Up-Rez an Image

Katie Furlong, who's also the graphics design powerhouse behind Edit Well, sent me the following tip for 
up-rezing images in PhotoShop:

Here’s a tip about up-rezing pictures that I learned from a photographer about a year ago 
that has been handy for me. Assuming you use Photoshop, go to Image > Image Size. In 
the dialogue box that comes up change your Pixel Dimensions to whatever percentage you 
need to increase it by plus 20% (In this example, I used 200%) and change the resample 
image to Bicubic Smoother.



Then, repeat the process by going to Image > Image Size and changing the Pixel 
Dimensions to 80% and then change the resample Image to Bicubic Sharper (this helps to 
sharpen it).

Tthe finished version isn’t super sharp, but it’s more readable when compared to the original. 
This trick works best with digital photos, but I’ve also used it to up-rez a HD screen capture 
to put it on a printing press.



Larry replies: Thanks, Katie.

UPDATE: Tom Wolsky writes in with an even better way to handle up-rezing:

A better way to do upsampling is to upsample in 10% increments, rather than upsampling at 
200% and then downsampling to sharpen. By upsampling incrementally you allow 
Photoshop to use its smoothing on each step of the process rather than trying to do it on a 
huge chunk. It works quite a bit better. It's simple to create an action to do this, just repeat 
the action multiple times very quickly, or build a single action with a stack of 10% increments 
and you can do it in seconds. 

Larry replies: As always, thanks, Tom! 

[ Go to Top. ] 

Speed Changes in Camera vs. in Final Cut Pro

Ben Balser, FCP Trainer and Edit Well author, sent in the following comments:

I did this exercise to help a former student understand the difference between creating speed 
changes in the camera (Over/Under Cranking), as opposed to making things speed up or 
slow down in an NLE, such as Final Cut Pro. I found the results very interesting to see next 
to each other.

http://www.bbalser.com/video/Slo-Mo_Side-By.mov 

First, this shows the HVX-200 in-camera speed changes (DVCPRO-HD) 720p24 with the 
"variable frame rate" set to 60 fps (in-camera over cranking for native, frame accurate slo-
mo), then conformed with FCP's Frame Rate Converter to a 720p24 Sequence.

Next in it is the same shot, native 720p24 with it's Speed variable in Final Cut Pro set to 40% 
to match in the same Sequence. Shown twice, the first "Post" slo-mo is with frame blending 
off, the second with frame blending on, to show the two different effects it gives.

I think this shows the difference between "Film" slow motion (frame accurate), and Post 
Production (Faked Frames) slow motion.

I didn't expect this to come out so well. It's actually Bourbon St. this past Mardi Gras day.

Larry replies: Ben, this is a great example of the difference between the two. Thanks for sharing it.

[ Go to Top. ] 

Editing 24 fps in PAL

http://www.bbalser.com/video/Slo-Mo_Side-By.mov


Kevin Fitzgerald writes:

I recently shot a doc on a PAL DVX100 camera in 24p Advanced mode.

What is the best way to capture and edit this footage in FCP?

Larry replies: Hmmmmm.... Since I don't shoot PAL on a regular basis, I got some help on this from 
Andreas Kiel, who writes:

Yes, this is possible, I did this all the time with my little Pana - until it "vanished" in 
Afghanistan last year.

Here the workflow:

1.  Use 24 PA
2.  Capture the clips to real 24/23.98
3.  (Optional) Use Compressor or something similar to convert (stretch vertical) all 

captured clips to PAL, I would recommended to do this with the finished movie to 
keep correct timecode as long as possible.

4.  Edit just as normal with 24 NTSC or PAL*, 23.98 NTSC or 25 PAL*
*(it depends on what you did in option 3)

5.  Use Compressor or something similar to convert the final cut - if you haven't done so 
before.

Also note - you will get a 4% speed change and audio has to be adjusted. It's obvious here 
PAL-land since most of the TV versions of 24 fps films are done this way.

We mostly used this set up to match mix the DVX100 US 24p/pa with 16mm (at 24) 
documentaries. It had quite a lot of advantages. We were able to edit as "normal" in 24 and 
with the final product it was essentially a snap of fingers to get the PAL and NTSC releases 
and a blowup to film.

Larry replies: Thanks!

[ Go to Top. ] 

Working with a Multiclip Sequence

John Warner writes:

It would be really useful in my workflow if Final Cut could add a feature whereby you control 
click on a clip in the browser and from a drop down menu -- create a new sequence based 
totally on the properties of the selected clip. This should reduce or eliminate the rendering 
which results in the mismatch between clip content and sequence settings.

Since I am creating time lapse projects in other programs (Quicktime Pro, Motion, After 
Effects), it seems that the Easy Setup sequence settings don't easily match up with the 



content I begin with.

Larry replies: John, this feature already exists in FCP 5.x, but it's hidden. Here's what you need to do.

1.  Select the clip in the Browser you want to create a special sequence for.
2.  Select Modify > Make Multiclip Sequence.
3.  Click OK in the resulting dialog box. The Default settings are fine.
4.  Throw away the folder that appears in the Browser, you don't need it.
5.  Double-click the new sequence to open it in the Timeline. It will have your clip contained in a new 

sequence that exactly matches the characteristics of your clip. 

Simple!

[ Go to Top. ] 

Monitoring HDV

Pete Hoare writes:

I'm having a few issues getting the video to play externally back to my camera. I was under 
the impression that when a camera was plugged into the firewirer (in this case its a sony 
HDR-FX1e) and in play mode, you could set it so external video would play to the camera. I 
had planned on plugging a TV or video monitor into the camera via an AV cable, so I could 
then view the video back on a proper monitor.

Is this even possible?

Larry replies: Unlike DV, HDV does NOT support playback to an external monitor via FireWire. The video 
compression is just too complex.

This can be solved either by converting HDV into a more friendly codec during capture, or using a capture 
card to off-load the video monitoring from the CPU, or, just deciding you like it on your computer monitor.

HDV is not an easy format to edit and many of the things we take for granted with SD video are not 
possible with HDV.

[ Go to Top. ] 

Using Garbage Mattes

Ayrod Seffak writes:

I have a question for which I can not find an answer. I have a footage with the boom mic 
showing at the top of the frame (present on about 2 seconds of PAL footage), I am trying to 
remove that boom in FCP but with no success. I thought I could send the clip frame by frame 



to Photoshop, erase the boom, then send the doctored frame back to FCP, but Photoshop 
does not do that on clips, it does it only on still frames.

Please, if you know of any other way to solve this problem, let me know.

Larry replies: There are many ways this can be done, using Final Cut, Motion, After Effects and a variety of 
other programs, but they rely on two things:

1.  That you have a piece of video where the mike is not showing that you can use to replace the 
portion of the video where the mike is in the shot. This video is called the "clean plate," or "clean 
background plate."

2.  That your camera is on a tripod so that both shots are steady.

Here's an article that illustrates how to do this using garbage mattes in Final Cut:

http://larryjordan.biz/articles/lj_garbage.html

UPDATE: Jeremy Traub writes in with another approach: 

Ayrod Seffak asked about retouching individual frames in Photoshop. Here's a way to do it with Photoshop, 
without the two limitations mentioned:

The easiest way to do this is to go though Adobe ImageReady, which comes with 
Photoshop. Just open the .mov file with ImageReady. Each frame of your movie will become 
a new layer. Now File > Save As... a PSD file and use the clone tool to your heart's content 
in Photoshop. When finished in Photoshop, use Photoshop's File > Scripts > Export Layers 
to Files. (You could also do everything in ImageReady, and use its File > Export > Layers as 
Files...) I recommend exporting as PNG files.

To avoid problems with gamma shift or lossy codecs, create the .mov file to be retouched as 
follows: from Final Cut Pro, Export Using QuickTime Conversion using the none-filtered PNG 
codec with no aspect ratio correction.

Incidentally, QuickTime Player can easily convert an image sequence back into a movie file 
(this requires QuickTime Pro, which comes with Final Cut Pro). From QuickTime Player, do 
File > Open Image Sequence..., then select your files (filenames must be less than 32 
characters). Now File > Save As... and save as a reference movie.

Michael Grenadier adds the following caution:

You should almost never import an image sequence using this technique. The large number 
of files involved in an image sequence will seriously clog your FCP project (this is the voice 
of experience speaking). FCP will take a long time opening the project and in particular 
saving the project will be equally sluggish. It's much smarter to use QuickTime to import an 
image sequence and save as a quicktime movie. By default, it will use the same 
compression as the image files so you can avoid any additional compression or you can do a 
save as any other codec normally available. 

Larry replies: Jeremy and Michael, thanks for sending these in! Keep in mind that PNG is an 8-bit codec. 
This technique will work fine for 8-bit video, such as DV and DVCPro-50, but may show banding when 
working with 10-bit video.

http://larryjordan.biz/articles/lj_garbage.html
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A Fast Way to Modify Multiple Text Clips

Richard Day writes:

I was putting together a large number of captions, but didn't know whether the client would 
like the color I had chosen.

So I set a number of captions to 90% gray in Boris Calligraphy, then used the Final Cut Pro 
TINT video filter to color them. If you need to change the color later, just change the tint in 
one clip, remove existing filters by selecting all other captions in the timeline and remove 
attributes: filters, then apply your modified filter set to all the captions. Keeping the captions 
in the same video track helps in selecting them.

Now if I could only do this with the font and size...

Larry replies: Funny you should ask. Andreas Kiel wrote an article for the January issue of Edit Well that 
talks about how to use XML to make changes to clips MUCH faster than you can inside FCP.

The idea is to export your sequence as an XML file (which, like HTML, is a text file). Then, using the global 
search and replace functions of a text editor, like TextWrangler, change your font, size, color or other 
general attribute from what you have to what you want.

You can either read the full article in Edit Well, or experiment on your own. A good tip is to create one text 
file that looks the way you want, that way, you can simply copy and paste the formats you want.

[ Go to Top. ] 

More Image Advice

Dave Haldiman, of Madison, Wisconsin, writes:

What suggestions can I tell to the art director for providing image files specifically for video, 
that will avoid the pixelation problem? Is there a filter that will smooth edges of graphics and 
text, without blurring them?

Larry replies: Still images cause more problems for Final Cut users than any other subject, except for 
system setup.

Keep in mind that video, unlike PhotoShop is EXTREMELY low resolution. Also, pixelization will be 
accentuated when displaying the videos on an LCD monitor at more than 100% size and viewing the 
monitor up close.

http://www.peachpit.com/editwell


Rule #1: All video is bitmapped at a fixed size and resolution. This means, by definition, all images are 
composed of small rectangular pixels. Any edges that are not perfectly horizontal or vertical will always 
show stair-stepping.

Because video is fixed in resolution, all you are doing when displaying video to a larger screen is making 
the pixels bigger -- and, thereby accentuating the pixelization. The worst thing you can do is look closely at 
video displayed on a large monitor.

Here are things to avoid for your text and images:

●     Serif fonts
●     Point sizes smaller than 24 point
●     Thin horizontal or vertical lines
●     Lines that are almost, but not quite, horizontal or vertical
●     Lines thinner than 4 pixels
●     Finely detailed images
●     Curvy fonts or lines

Also, because video is a fixed size, if you zoom an image, all you are doing is making the pixels bigger. 
There is NO anti-aliasing in video. Therefore, you are simply aggravating your pixelization.

Remember, it is NOT the dpi of the image -- unlike print -- it is the total pixels across by the total pixels 
down. If you want to zoom a 4:3 NTSC image, create it at 1800 x 1350 x 72 and you'll be able to zoom it by 
2.5x.

Video is best at showing motion and emotion. For this reason, keep your graphics moving and people won't 
notice the stairstepping so much.

Here's an article that goes into a lot more detail:

http://www.larryjordan.biz/articles/lj_grfx_look.html
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Capturing Video Into FCP Using iSight

Isazaly Mohd Isa sends in the following technique:

This is a cool feature if you're doing video blogs, podcast or tutorials (like me!) and have 
direct access to FCP as your non-linear editing software. FCP allows you to capture video 
from your built-in iSight camera on your MacBook Pros! So, after these few settings, the next 
time you Press CMD+8 (or File >Log & Capture), you'll be able to see the "live input" and 
use the "Capture Now" button and..... "Action!"

Create an Easy Setup with the following information (change to NTSC as needed!) :

http://www.larryjordan.biz/articles/lj_grfx_look.html






Larry replies: Very cool! Thanks.
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Alexis van Hurkman has a New Book on Color in FCP

Since starting Edit Well, I have become a huge fan of Alexis van Hurkman. His books on color and color 
effects in Final Cut are excellent and he now has a new book out on Advanced Color, which I used as one 
of my sources during my recent seminar tour.

Alexis writes:

My newest book, "Encyclopedia of Color Correction - Field Techniques Using Final Cut Pro," 
is now available from Amazon.com. It's an encyclopedically organized collection of articles 
that combine specific color correction techniques with other general information relevant to 
the desktop colorist and finishing editor.



The majority of articles are accompanied by hands-on exercises you can do with the 
included DVD-ROM. Although the exercises are designed for Final Cut Pro, I wrote the 
material to be general enough for nearly anyone working with an application that supports 
some type of three-way color correction.

If you're a nonlinear-based colorist who's looking to expand your range of techniques, or an 
online editor who's increasingly called upon to do color-correction while finishing projects, 
then this book is for you. It compiles methods and information I've found valuable while 
working with my own clients, and aims to clear up the confusion surrounding issues like 
gamma and color space conversions in the Final Cut Pro community.

Larry adds: The book is published by Peachpit Press and is available in fine book stores and Amazon.com. 
I recommend it highly.

[ Go to Top. ] 

Reader Mail

Lots, and lots of reader mail this month. Let's take a look at what we've got! So much that 
I've moved it to a separate page. 

Click here to read Reader Mail.

[ Go to Top. ] 

Wrap-Up 

Well, that's it for another issue. Please take a few minutes and:

●     Subscribe to Edit Well
●     Visit our store and buy a DVD, or two. 

Your support for our seminars and products keeps our website, and this newsletter, free. 

Thanks for all your comments and questions. I love hearing from you because when you share your ideas 
and suggestions, we all learn.

Until next month, take care, and edit well.

Larry

http://www.peachpit.com/bookstore/product.asp?isbn=0321432312&rl=1
http://www.peachpit.com/editwell
http://www.larryjordan.biz/store/index.html


 

Newsletters
Sign up for Larry's FREE

Monthly Newsletter!

    

Reader Mail

Newsletter 33 - Feb/Mar 2007 

Reader Mail

In this section, there are several questions where I don't have answers. Take a look at some 
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Return to Main Newsletter 

Time to Go SPLAT

Jody Roach, of Proscan Imaging, writes:

I am an in-house video producer for a medical company in Cincinnati. I am currently using 
your tutorials on Lynda.com to make the transition from Avid to Final Cut. First of all your 
tutorials are incredibly helpful, it has been two days and I’m already starting to feel at home. 
While watching I found your thoughts on not “Apple-ing” your computer very entertaining. At 
my school, Xavier University, we use the term “Splat” for the command key because of the 
four leaf clover / squished bug logo that Mac uses to label it. 

So I couldn’t help but ask … would you ever “Splat” your computer?

Larry replies: Um, never in public.

[ Go to Top. ] 

Switching Between Applications

Dale Lawson writes:

Thank you for the great presentation style you have and keep up the good work.

I noticed that when you switch between applications, in your Lynda.com tutorials, they 
appear as icons on the desktop. I'm wondering if you could tell me how to make that happen 
on my computer. I have pretty much pulled what little hair I have left out trying to figure out 
how you do that!

Larry replies: Sure.

Hold down the Command key (or SPLAT, if you prefer) and tap the Tab key. A list of all open applications 
appears. Keep tapping the Tab key until you select the one you want, then let go of the Command/Splat 
key.

[ Go to Top. ] 

Exporting from Final Cut

Jim Geduldick writes:



Got a quick one for you. I'm working on some animation in 10-bit uncompressed and doing 2 
flavors of exports. One is with markers for batching and the other is by scenes for animating 
in frames. One thing i have come across before is that when i set a in and out point and 
select area to export i always get the 1st frame of the next edit. Why is that?

So my workaround is either bringing the whole thing into AE7 and setting workspaces or in 
FCP setting in and out points and then going back 1 frame.

Any idea why i can't just set my in and out points on exactly where i want them on the out 
point. Even with the roll tool i get the 1st frame of the next edit manually.

Larry replies: It depends on how you are setting your Out point. Final Cut is an "inclusive" editor. This 
means that FCP always includes the frame you see displayed in the Canvas when you are setting the Out.

For instance, if you are in the habit of using the Up/Down Arrow keys to position the cursor to set the In 
and Out, your In's will always be correct, but your Outs will be off by one frame.

 
Note the out is set one frame past the edit point.

The Up/Down Arrow keys always position the playhead on the In of the previous or next clip. This is perfect 
for the In, but one frame off for the Out.

To prevent this problem, when you use the Down Arrow key, press the Left Arrow key once to back up one 
frame then set the Out.

 
Moving the playhead back one frame sets the Out correctly. 
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Gamma Shift in H.264 Video

Tim Wilson writes:



I've just exported a 12 min. sequence as a reference movie to Quicktime (not via Quicktime 
conversion) from FCP 5.1.2, and noticed significant color shift (more, and more sickly, 
green), and noticeably less color saturation than shows on precisely the same monitor when 
playing the footage in the FCP Canvas.

Can you tell me what gives and how to fix?

Shortly thereafter, Tim sent a second note:

A little poking about and I found a number of comments on an apparent bug in H.264 
implementation in Quicktime 7, namely the very gamma shift that I ran into earlier today. You 
can learn more about it here:

http://forums.creativecow.net/readthread/20/856650/856650

I still haven't found any fixes, but am guessing the workaround is to export (if using QT and 
not compressor), as MPEG-4 or something else, avoiding H.264.

Larry replies: Thanks for letting us know.
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Closing Multiple Viewer Windows

Patric Anderson writes:

Larry, do you of a way in Final Cut Pro 5.0.4 to close, all at once, multiple open "Viewer" 
windows ? It get mighty tedious having to click on the tiny dot that closes each one… Any 
help is greatly appreciated.

Larry replies: Patric, I tend to avoid using multiple Viewer windows (created by tearing the Video tab out of 
the Viewer and dragging it away from the Viewer, because there is no easy way to close all of them. This 
technique also makes using the automated editing tools in the Canvas difficult.

However, one faster technique you can use to close a window is to select the window by clicking it and 
pressing Command+W.

[ Go to Top. ] 

Retaining PhotoShop Layer Effects on Import to FCP

Pete Hoare writes:

I tried importing a PhotoShop image of a red-laser-style line. This was for an effect where 
text would slide under the line, and re-emerge on the other side saying something else.

http://forums.creativecow.net/readthread/20/856650/856650


I used the line tool to make the line, then used an outer glow to add a nice fluffy laser edge 
to the line. I then turned off the background layer, saved it and imported it into FCP, but it did 
not import the blending. I have also noticed this when using the blending options to make 
fancy text for titles.

I could import the line with the blending if i flattened the entire image, but this removed the 
layering, so i could not have the transparent layer and have the text slide under neath the 
laser...

How can I import the PSD and keep the blend features?

Larry replies: Pete, All layer effects in PhotoShop need to be rasterized, or rendered, in order for Final Cut 
to read them. This is because Final Cut does not know how to read PhotoShop layer effects directly. 

To rasterize a layer, or all layers:

●     Select the layer you want to change in the Layers palette
●     Go to PhotoShop's Layer menu and select Layer > Rasterize > Layer (or All Layers).

UPDATE: Andreas Kiel, however, begs to differ:

That's not true in most cases. Just save/export as layered TIFF from PS (I think this works 
starting with version 5 or 6). This keeps the layers, transparencies and effects intact and 
comes into FCP as standard single layer graphics - ready to use. You can even use the FCP 
"Open in Editor" and do changes to the layers in PS again.

That why I do a lot of subtitles using XML to PS-scripting for final delivery. The text is still 
editable as text with all the effects from PS retained i.e. outline, drop shadow or whatever.

Larry replies: Andreas, thanks! 

[ Go to Top. ] 



Render Files Not Updating

Jonny Elwyn writes:

Just to say thanks a bundle for your newsletter and website - I'm learning a lot and the tips 
and tricks have saved me from a tight spot on more than one occasion.

I just thought i'd drop you a line about a problem i've been experiencing on FCP 5+ where it 
seems to hold on to old renders of shots and doesn't up date.

So if i have colour graded a clip (or added anything that requires it to be rendered) then i 
shorten the shot (or even just alter the grade), it often will keep the previous rendered 
version of the shot - therefore playing phantom frames.

The way to solve this seems to be to get it to re-render the section - by adding/removing 
effects. although sometimes this doesn't work and i have to copy and paste the clips to make 
them need to be rendered again and then re-render them.

This is obviously time consuming and annoying.

i work in a facility with multiple suites and it seems to do it in more than one suite (they're 
now all 5.1.2 and i never noticed it before on 5)

Do you know why it might be doing this?

Larry replies: First, here's a faster way to delete render files for a clip: select it and type Control+B twice -- 
or select View > Clip Enable twice. This toggles clip visibility off and on, which also deletes render files for 
that clip.

But as to the larger issue, I don't know why this is happening. If any readers have an idea, I'll be glad to 
pass it along.
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ProTools / Soundtrack Compatibility

Alex Ripstein writes:

If I do all the audio post production of a film project, up to the final pre-mix, but I have to do 
the final mix in a big studio facility that works exclusively with Pro Tools HD, is my 
Soundtrack Pro project compatible, If so, how do I have to export or save it...?

Larry replies: Essentially, no.

Soundtrack does not currently support OMF files, which is what your ProTools engineers will need.

You would be better off to use Soundtrack to work on individual elements, bring them back into Final Cut, 
then export the entire project out of Final Cut as an OMF file.



However, check with your audio folks, they may prefer to get all files in their native state and make all 
adjustments at the final mix.
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Outputting Audio from Soundtrack Pro

Jon Rutherford provides the following Soundtrack Pro tip:

If you want to output audio from Soundtrack Pro using FireWire here's something to keep in 
mind: When you bring video into STP and set the Video Output to Firewire it outputs ALL 
audio. But if you do NOT have a video clip in the project STP will NOT send audio out via 
Firewire. Seems to be a bug. 

A work-around I used is to create a “slug” clip in FCP with no audio. Import it into STP and 
trick STP to send out the audio via FW.

Larry replies: Thanks, Jon.

[ Go to Top. ] 

Audio Playback Problems

Lauri Astala writes:

I wanted to contact you concerning a problem with playback when using audio tracks - 
there's no problem while not using audio. I'm working for the first time with HDV (1080i50) 
material. In my project, the timeline has only raw video and audio clips in it (no effects or 
fades on either video or audio), and default amount of tracks (1 video track and 4 audio 
tracks). The problem is that there comes quite frequently dropped frames during playback, 
and I find it very disturbing.

I noticed the problem first time when my friend made some audio (voice over) files for the 
project. He made them as mono .AIF files (48 kHz, 16-bit integer, data rate 93.7K/sec), and 
the setting in the sequence is the same (48 kHz, 16-bit integer) except stereo, of course.

Larry replies: Lauri, thanks for all the details you provided on the problem. However, your difficulties are 
caused by using compressed audio. (The tip-off was the 93.7K data rate - more on that in a second.)

Final Cut HATES compressed audio. It does not play MP3, AAC, or AC3 files. It only likes AIF, WAV, and 
SDII audio -- all of which are uncompressed. An uncompressed STEREO AIF file has a data rate of 
1536.02 kbits/second. A MONO AIF file has a data rate of 768.01 kbits/second.

When you said your data rate was 93.7 KB/second, this struck me as too low. My suggestion is to either re-
record your audio and save it as an uncompressed PCM file (the technical name for AIF) or use iTunes to 



  
  
  
  
  
  
  
  
  
  

convert it into an uncompressed AIF format.

Here's an article that describes how to use iTunes to convert your audio.

[ Go to Top. ] 

The Audio Master Fader

Shaun Kitka writes:

In your Beyond the Basics DVD training, you mention that the Master Audio Fader, in the 
audio mixer, controls the entire application, not just that particular project. Is this still true in 
Final Cut Pro 5.1.2?

Larry replies: Yes.

[ Go to Top. ] 

Working with USB Drives

Paul Tait, of Nimbin, Australia, writes:

I recently needed more space on my scratch disc as I had to change projects and so moved 
this project over to the only place with space enough, a USB Iomega 160 GB disc. At first, it 
wouldn't accept the files as there were characters that I used in logging that the USB 
wouldn't accept, so I removed the "&" and "/" characters and moved the lot. Now having 
moved them back to my scratch disc , FCP crashes immediately. 

Oh, dear! Is there something I can do to sort this out or has putting it to a USB disc been a 
fatal error? 

Larry replies: Sigh... well, there are several things you didn't do right.

Transferring to a USB drive would have been OK, but from your description, it sounds like it was formatted 
for Windows -- which is why it didn't like the & character -- and this, potentially, messed up all your media 
files. If so, there's a good possibility for damaged media. This MIGHT be a reason Final Cut is crashing.

Paul replies: I never thought to check the formatting of the USB drive. Thanks! Also, I got my project 
working again by moving the corrupt files out of the "capture scratch" folder. Then, when I opened the 
project, FCP just told me that the "media was offline", then went ahead and opened the project. So now I 
have a working project and can just recapture media, without having to remake the whole thing!!!

[ Go to Top. ] 
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More on Hard Drive Speed

I was reading a thread recently that included some specs on FireWire and USB2 hard drives. It said: 

●     The theoretical bandwidth of FireWire 400 is 400 Mb/s (50 MB/s) but because of the chattiness of 
the protocol, it is closer to 272 Mb/s (34 MB/s)

●     The theoretical bandwidth of USB 2.0 is 480 Mb/s (60 MB/s) but because of the chattiness of the 
protocol, it is closer to 100 Mb/s (12 MB/s)

●     By chattiness I am referring to the "communication data" each protocol uses between the computer 
and the hard disk, in addition to the data being read or written to the drive. The method for sending 
data for both protocols is in packets, but each handle those packets in very different ways. 

If you are unfamiliar with packets, here is a good link to read up. This article talks about Internet packets, 
but the overall idea is the same:

http://www.livinginternet.com/i/iw_packet_packet.htm

Here's another article that talks about USB vs FireWire:

http://www.usb-ware.com/firewire-vs-usb.htm

And one more:

http://www.barefeats.com/usb2.html
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Working with Stills and Composite Video

Charlie Wilson writes:

I am an editor with CBS Evening News in Wash, D.C. and currently use both Avid Express 
Pro and FCP. I use FCP to manipulate stills and then export them as .mov files for import to 
AVID just in case someone else has to recut. I think I have convinced the powers that be 
that I should be able to use FCP full time. The other rooms are all Avid Adrenaline XP rooms 
(and every one of them has a problem). Anyway, I have two questions that you might be 
able to answer.

First is hardware. AJA makes the wonderful uncompressed IO box, but I was wondering if 
there is any way to use that system in a server environment. Also, if I go on the road, usually 
with the White House Press which is still composite in/out and use the AJA IO mini box, do I 
have to stick to uncompressed, or are there selectable resolutions so my travel drive will 
hold more, like DV 50 or DV25.

Second is moving stills in FCP. 90% of FCP is pretty intuitive, but I am having a hard time 
mastering variable motion. I would like to be able to do what I can do in Avid Express Pro 

http://www.livinginternet.com/i/iw_packet_packet.htm
http://www.usb-ware.com/firewire-vs-usb.htm
http://www.barefeats.com/usb2.html


using "acceleration" to have a move start up and slow down at the end, but I can't seem to 
figure out the variable motion section of FCP. Is there a tutorial about that specific part of the 
program.

Larry replies: Charlie, first, the AJA IO series allows you to select a variety of different video formats you 
can capture. While uncompressed 10-bit will give you the highest quality, you should be able to get 
acceptable results, especially for news footage, by using the AJA IO to capture your composite news feeds 
as DV NTSC. And the file sizes are completely manageable using an external FireWire drive.

In answer to your second question, what I think you want to do is to create motion paths on images that 
allow you to change the acceleration into or out of a keyframe. The easiest way to do this is to control-click 
on a motion path keyframe...

... and select "Ease-In/Ease-Out." This adds two, almost invisible blue dots to the motion path. If you do 
nothing, you've already added a default amount of acceleration to your motion which, in many cases, will 
look just fine. However...

... if you grab the darker blue dot, closest to the green keyframe, by sliding this you can adjust the amount 
of acceleration. The spacing of the motion path dots indicates the speed of motion -- closer dots mean the 
clip moves slower, dots farther apart mean the clip moves faster.
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Compressing Video

John Warner, of Asheville, NC, writes:

A client requested a smaller proof movie from the 1 hour long, 13 GB DV footage I recently 
shot.

I first exported a reference movie on my G5 and tried creating an MPEG-2 file less than 100 
MBs for this purpose via Compressor. 

After 3 hours of crunching with another 2 hours to go I got desperate. And this is on a 2.5 
GHz G5 with 6 gigs of RAM.

I then discovered the following workaround:

1.  Export the sequence from FCP as a QT reference movie.
2.  Import the exported movie into iMovie.
3.  Share the clip (iMovie's term for export) for email or ipod.

My findings: 3 minutes to export the FCP reference, 20 minutes to import into iMovie and 35 
minutes to complete the export to email.

Not a stunning record but it certainly beats 5 hours. You seem to delight in real world tests 
especially when done by testy people.

Larry replies: Thanks, I would never have expected iMovie to be so efficient.
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Comparing MPEG-2 Encoders

Mark Trenery, of Canberra, Australia, writes:

As the finality of my DVD work depends so much on the encoder and its settings, I 
compared the output of Mac encoders to the highly vaunted Cinema Craft Encoder SP2 on 
the Win XP platform. Apple's Compressor 2.3 compares very well indeed.
Observations and some sample stills posted at:

http://www.netspeed.com.au/mark/encoders/Site/encoders.html

This is a work in progress, with more added as I get time to check outputs.

Larry replies: Here are three images that Mark provided to illustrate his test. The files are large -- PNG 
format to avoid JPEG artifacts -- the compressor he used is listed in the window title at the top of each 
image. 

●     Click here: Compressing for motion (1.7 MB PNG file) 

http://www.larryjordan.biz/assets/nxltr33/trenery_motion.png


●     Click here: Compressing for tonal values (2.0 MB PNG file) 
●     Click here: Compressing a transition (1.7 MB PNG file) 
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LP vs SP Mode in DV

Jack Freidog, from Santa Monica, writes:

I have question. I shot a project with a Sony 900 mini DVD camera. I shot it in LP mode. 
About 15-20% of it breaks up on the original tape. Breaking up I mean "glitches". There are 
some areas where they're aren't "glitches" on the original tape, but when I captured it on 
FPC, more "glitches" appeared that weren't on the original tape. (hmmm...)

Does FCP have problems importing and exporting mini-DVDs shot in LP mode? A fellow 
editor friend told me yes. He told me I would have problems
exporting.

Larry replies: Jack, there's very little good news here.

LP mode is a REAL problem if you want to edit. Your friend was right:

●     FCP does not like LP mode
●     LP mode causes glitches
●     Your best option is to dub the LP material ti SP -- BUT, that doesn't mean your timecode will 

change.

You can dub from LP to SP, keep the same timecode, then use FCP's Batch Capture mode to recapture 
your material.

Your problems are significant enough to warrant a test. Dub one tape, recapture the material -- which 
means none of your current work is lost, you are just replacing the media -- and see how it works.

Jack answers: 

I shot this on mini-DV tapes. There is no burnt time code. It's DV time code from the DV 
camera, and I have to manually start the decks. How can I get the time code to match?

Is it still possible to dub them matching the time codes????

Larry replies: Jack, all DV tapes have timecode recorded on the tape as part of the format. However, not all 
DV decks support duplicating timecode.

Here's the easiest way to do this: connect a FireWire cable between the two decks. Make sure your record 
deck is set to record at SP speed. Then, dub between the decks using Firewire. Your video, audio and 
timecode will match, and you'll convert your master tape from LP to SP.

http://www.larryjordan.biz/assets/nxltr33/trenery_tonal.png
http://www.larryjordan.biz/assets/nxltr33/trenery_transition.png
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Using Different Fonts in a Livetype Scroll

Carl, of Flag Media, writes:

Is there a way to use different font sizes in the same Scroll section.

When I use two font sizes in the scroll mode, one moves faster than the other. For instance I 
am using, by director's request, Ravie 30pt and Times New Roman at 36pt.

Times New Roman at 36pt catches up with the Ravie by the top of the screen. Is there a 
way to get these two to lock together?

Larry replies: Yup, I see it, too. Weird!

Here's what it looks like:

Apparently, the small text scrolls using a different baseline than the large text, causing them to scroll out of 
sync; even though both fonts are on the same line.



When we first talked about this, I thought I had a fix, but in testing it, I discovered it doesn't work. Anyone 
know how to fix this?
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Double-recording with a P2 Camera

Mary Glembotzky writes

I am shooting a 2-3 hour seminar than cutting it down to around an hour. I have the HVX 200 
and a MacBook Pro w/ the FCP suite. I was wondering if I could not only RECORD on dv, 
but at the same time capture into my OWC 250 second drive...? I'm thinking it would save 
input time...and it would be ready to rock in FC.

If so what would settings be? I have tried in log and capture in different settings (unclicked 
capture limit, tried batch. now etc.) I can't seem to find it in my manuals.

Larry replies: Mary, I have no idea. If any of our readers can suggest something, I will pass it along.

UPDATE: Ben Balser, FCP trainer in New Orleans, writes in:

You can't capture to a regular hard drive from the HVX200. The devices available (FS-100, 
CitiDisk) are not simple hard drives, but have little CPUs and RAM and a full Linux OS in 
them. You can dump from a P2 card to an On-The-Go drive after you shoot. But that doesn't 
solve the problem. The only two methods to record as Mary wants is: 

1- Firewire to [your Macintosh] and capture with FCP to an external hard drive. This may 
also require a Firewire card to give you the second data bus needed. Since all Macs only 
have one Firewire data bus that all the ports share, the bandwidth can be a problem. With 
regular DV, you may be able to get away with it, depending on the hard drive you use. 

2- Use the FS-100 or the CitiDisk. Although I must say the CitiDisk got off to a very bad start, 
and they are still working major kinks out of that system.

Hope this helps. I'd also recommend she start cruising the HVX forums at DVXuser.com.

Larry replies: Ben, thanks -- this helps a lot. 
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Capturing MXF Data from P2 Footage

Christian Domarus writes:



My question is this:

I will be receiving MXF file footage from a Panasonic HVX-200 (P2) camera via data discs 
(DVDs), to import into FCP.

Can you do this? I did a test and was unable to, but I may have been missing something.

Larry replies: The answer to your question is no -- currently, Final Cut Pro does not natively read MXF data 
from the Panasonic P2 camera. However, a program called P2 Log does -- and this allows you to get the 
MXF data into Final Cut. You can learn more about the program here.
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More Reader Advice Needed

Eric writes:

I'm looking for a VERY inexpensive camera to use as a deck for my Panasonic DVX-100A. I 
need a camera that I can use to capture 24p footage into Final Cut, so that my DVX camera 
can be used just for shooting. What should I buy?

Larry replies: I have no idea -- perhaps a reader will have a suggestion.
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Problems Burning Dual-Layer DVD Disks

Tim, from Santa Monica, writes:

We're using Final Cut Pro 5.0.2 (latest) and when we go to DVD Studio Pro, we're having a 
hard time burning the Dual Layer -R discs.

Larry replies: My first advice is to give up burning on dual-layer disks. The technology is not ready for prime 
time. Not only is the technology on the edge of coming unglued, but the compatibility between systems is 
almost non-existent. You will get a significant number of viewers who will be unable to play your disks.

Dual-layer replicated disks are fine - dual-layer burned disks are not.

My strong recommendation is to create two single-layer disks and package them together.
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Return to Main Newsletter 

http://www.imagineproducts.com/P2log.htm


Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign up at www.
larryjordan.biz.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not sold, rented, or 
bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. However, due to the 
variety of possible system and software configurations, the author assumes no liability in case things go 
wrong. Please use your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has not been 
reviewed or sanctioned by Apple or any other third party. All trademarks are the property of their respective 
owners and are mentioned here for editorial purposes only.

Text copyright 2007 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter may not be 
reproduced or published in any way, in whole or in part, without specific written permission from the author. 

Links to my website home page or articles are welcome and don't require prior permission. 
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